
ANIMAC II, Version 2.12
Released: November, 1996.
See conditions for distributing copies of ANIMAC at the end of 
this document.

To ensure trouble-free operation of ANIMAC,
please read this document!

IF YOU DO NOT READ THE ENTIRE DOCUMENT, PLEASE NOTE: 

ANIMAC is MEMORY-HUNGRY, since it stores all images in memory for fastest 
possible access. DO NOT run ANIMAC together with other programs! If ANIMAC locks 
up when you try to run it, requiring you to restart your computer, then ANIMAC's 
memory size is incorrectly set, or you have a conflictioning extension (see below). If 
your Mac has 16 Mb of RAM (of which at least 11 Mb free), please set ANIMAC's 
"preferred memory size" to 10.000 K (i.e. 10 Mb). If it has significantly more, set the size 
to a maximum of16.000 K. If you have 16 Mb or less, please set it as described below. 
(ANIMAC is delivered with a setting of only 2200 K, enabling it to run on older Macs with 
as little as 4 Mb RAM.) 

ANIMAC is incompatible with some extensions. To bypass extensions, start your Mac 
and hold down the "Shift" key until you see the text "Extensions off". Then run ANIMAC. 
(The extensions will be back on the next restart.)

INSTALLATION:

• IMPORTANT:    If you have an old version (or demo version) of ANIMAC on your hard 
disk, you should remove the old ANIMAC II and ANIMAC DATA files before copying the 
new version to your hard disk. The animation and sound files are still fully compatible 
and do not need to be removed.

• If you have downloaded the ANIMAC Demo and are reading this, then you do not need 
to extract any files; skip the next paragraph.

• BEFORE USING ANIMAC, FIRST COPY THE ENTIRE ANIMAC FOLDER TO YOUR 
HARD DISK. THEN EJECT THE FLOPPY DISK AND OPEN THE NEWLY COPIED 
ANIMAC FOLDER ON YOUR HARD DISK. DOUBLECLICK THE SMALL FOLDER 
ICON WITH ARROWS. PRESS THE "EXTRACT" BUTTON IN THE APPEARING 
WINDOW. THE DATA IN THE FOLDER WILL BE EXTRACTED AND PLACED IN THE 
ANIMAC FOLDER. (The extracted data cosists of some sample animation, x-sheet and 
sound files, and an electronic version of the User's Manual.) 



• If you have purchased ANIMAC and use the software enabler (also called "dongle"): 
Please follow the hardware and software installation instructions in the ANIMAC User's 
manual. You must also install the software for the camera from the enclosed two disks. 
Please see the camera manual for instructions on how to install this software. ANIMAC 
will not function correctly unless installation is properly made. If you have a Quadra 700, 
900 or 950, PowerBook 140, 160, 170 or 180: you may need some of the special 
software that is provided in the "Problems?" folder on your ANIMAC disk. Please check 
the "Read this" file in that folder.
If you are unable to solve a problem, please phone or fax your ANIMAC supplier.

• A freely distributed copy of ANIMAC (i.e. without the "dongle") will run in "demo" mode 
and does not need any camera software. Some older Macs may not be able to play 
ANIMAC sounds.

SETTING ANIMAC's MEMORY SIZE:

• ANIMAC is memory-hungry. To optimize the number of drawings ANIMAC can handle, 
you must check the amount of free memory in your Mac. To do so, quit all programs. 
Check the "About this Macintosh" in the Apple menu. Then highlight the ANIMAC II 
program by clicking on it ONCE, and then choose "Get info" in the "File" menu. Set the 
"Preferred Memory Size" in ANIMAC's Info to at least 500-800 K LESS than the "Largest 
Unused Block" of memory that you see in    "About this Macintosh"window.    See 
example below:

 



f the preferred size is set too high, ANIMAC may not function correctly, and printing from 
ANIMAC may be impossible. If it is set too low, ANIMAC may crash. Please periodically 
check this setting, especially if you add more memory to your Mac (preferred size can 
be set larger) or otherwise change the system (adding extensions, for instance, then 
you have to reduce the preferred size).    An absolute minimum of RAM is 4 Mb; this 
usually means about 2500 K free memory, and a preferred size of 2200 K. This suffices 
for only a little over 100 drawings. With 10 Mb free RAM, ANIMAC can handle up to 850 
drawings. Please note: There is no use to set the Preferred size to more than 10.000 K - 
ANIMAC cannot use more than 10 Mb RAM, even if you have more available. One 
exception: if you have more than 16 MB free RAM in your Mac, and ANIMAC crashes, 
set the memory size to 16.000 K.

 AVOIDING SOFTWARE CONFLICTS

• Do not run any other applications simultaneously with ANIMAC. If you do, you may 
experience jerky movement and imprecise timing. (Check the application menu in the 
top right corner of your screen — only ANIMAC and Finder should appear.) 

• If you experience "jerky" animation that seems to stop momentarily, you may have 
some program or background task running in your Mac. Some CD-ROM software may 
also cause jerkiness. Please ensure that all unnecessary extensions are switched OFF 
(use "Extension Manager" in the Apple Menu's Control Panel.)    For ANIMAC, you only 
need the QuickTime and camera extensions. (Your specific Mac model may require 
additional extensions. See your Mac manual before disabling any of Apple's 
extensions.) 

• If you are running the demo version, it is simpler to restart your Mac while holding 
down the shift key until you see the "Extensions disabled" message. (You'll get them 
back on the next restart.)



• Please note that the Apple software "At Ease" and "Launcher" should NOT be used 
together with ANIMAC. These programs run in the background, "stealing" processing 
time from ANIMAC, also causing jerky animation. To disable "At Ease", go to its Control 
Panel and switch it OFF. To disable "Launcher", remove it from the Startup folder (in the 
System folder).    "At Ease" and "Launcher" are usually factory-installed on the Performa 
Macs, so if you have a Performa, please ensure these programs are disabled! See yor 
Mac manual if you need further information on these programs.

• If you experience problems with the ANIMAC software, please disable all unnecessary 
Extensions. A conflict exists between ANIMAC and some scripting and other extensions. 
If the ANIMAC program freezes, please restart your Macintosh,    go to the Extension 
Manager control panel and temporarily disable all extensions EXCEPT the following: 
QuickTime; any system enablers your computer needs; the camera software. These 
must be active for ANIMAC to function fully. Then restart again and try running ANIMAC. 
If this does not help, please contact your ANIMAC supplier with an EXACT description 
of the problem and any error messages. You can also E-mail: animato@sci.fi 

• Do not use a screen saver (such as After Dark — you may get flying toasters ruining 
your animation...) and don't use virtual memory. (Virtual memory will slow the display 
and make the action jerky — get more RAM if you need more picture memory.)

    HARDWARE CONSIDERATIONS

• Do NOT plug or unplug the software enabler when power is on.

• If you wish to record sound into the ANIMAC program, use the Control Panel "Sound" 
in the Apple menu to choose the appropriate input. If your sound source is a tape 
recorder or amplifier please consider the following: There are two types of microphone 
inputs, depending on the model of Mac. The "old" type has a low-voltage input, which 
may cause distorted sound if you connect a tape recorder directly to it. You may have to 
obtain a "sound attenuator cable" that lowers the voltage. Such a cable can be provided 
by the ANIMAC supplier. The "new" type can handle a line-level signal directly. (The 
"new" type is found on the Performa/LC 475 and newer Macs, and on all the 
PowerMacs). NEVER use a sound output other than "line level", i.e. do NOT connect a 
loudspeaker output to the Mac's microphone input, with or without attenuator! Failure to 
follow this instruction may cause damage to your Macintosh! 

•
If you use any program with sound input that allows you to change the sound input 



specifications, please make sure that you reinstate the correct settings when running 
ANIMAC: Mono, 22 KHz sample rate, no compression. Otherwise the soundtrack 
display will not be correct.

• To all PowerBook users:

You must switch off both "Resting" and "Processor Cycling" from the PowerBook Control 
Panel in the Apple Menu. Otherwise the animation will be jerky or very slow. The battery 
life is shorter than usual when these options are off, so be sure to switch them back 
again if you plan to use your PowerBook for other purposes on battery power.

A PowerBook has a "slower" screen than an ordinary monitor. For this reason, a button 
"Pause between scans" is available in the camera adjusting display. PowerBook users 
should find it useful.

When playing a scene with sound on a PowerBook, the action may appear jerky if the 
timing is set to more than 24 fps. The timing will still be correct, however. ANIMAC may 
skip a frame whenever the display's slow update wouldn't cope. (This is better than 
having inaccurate timing, though.) The problem only occurs when playing sound. 
Deselect the "Play Sound" button to see the animation smoothly.

    New features, not described in manual:

    Color / B&W Camera: In the Options menu, you can adjust the settings to correspond 
with either a B&W or a color camera. 

"Line" button in the Adjust Camera window: In addition to the 3 contrast levels, you can 
choose enhancement of pencil lines. This "picks up" weak lines and strengthens them, 
and also brings out detail in heavily drawn areas. The image is a little grainier, though. 
This only works with a color camera.

"Sound start point" in the exposure sheet's Options menu allows you to specify where in 
the currently open sound file you want playback to start when viewing the animation. 
This enables you to record a long sound covering many scenes (or a storyboard) and 
later use the same sound file for many animated scenes by specifying a different 
starting point for each scene. The value (in seconds) can be input as a decimal number 
(i.e. "5.34") enabling you to sychronize the sound to the exact frame. This start point 
value is saved when you save the exposure sheet. The sound file is recorded and 
stored only once. Sound files having a name that differs from the name of the drawings 
and/or x-sheet load automatically when a scene is loaded, provided that the sound file 
was loaded into memory at the time the scene was saved. 



"Pause between scans" button is added to the Adjust Camera screen to facilitate 
adjustment on certain PowerBooks. See above.

"Show scene Info" in the Options menu of the Main Display will first display a window 
like the one used to open a scene, but instead of loading a scene you will get a list of 
information about the chosen scene, including aspect ratio, number of images, and if 
there are properly named x-sheet & sound files present in the same folder, the length 
and timing of the x-sheet, sound length etc.

    Keyboard setting of brightness: In "Adjust Camera" or "Record" mode, typing an 
uppercase "B" or "D" (shift key + letter key) lets you adjust the camera brightness by 10 
steps with every key press. A lowercase "b" or "d" will adjust one step at a time. 
Pressing the "P" key will disable the rasterized preview when recording, for somewhat 
faster recording. 

MARKING UP A SOUNDTRACK:

First, record or load a sound into ANIMAC. Then go to the exposure sheet, erase the "S" 
you find on the x-sheet. Choose "Show soundtrack" in the Options menu.

The soundtrack will be displayed just like an optical soundtrack on a filmstrip. You can 
actually see distinct sounds, and you will soon learn to recognize separate words in 
spoken dialogue. 

By marking a small portion of the soundtrack (press & hold down mouse button - drag - 
release mouse button) you can listen to that particular part by clicking on "Show 
sequence" or by pressing return on the keyboard. By marking successively smaller 
parts of the soundtrack, you can localize syllables, and even the individual letters of a 
word. 

HINT: Remember that it is more important to animate the general shape of the mouth 
than to draw a mouth position for every letter in a word! A good way to practice is to 
slowly speak the sentence in front of a mirror and study your own mouth movement. 

ANIMAC Questions and Answers 

Q: Is there any hardware that has to be istalled inside my Mac? How much RAM do I 
need?
A: No internal hardware is necessary. This is the beauty of the new ANIMAC version. 



You just plug in the camera and the software enabler into the Mac's serial and ADB 
ports, and you're ready to shoot! The ANIMAC can run in as little as 4 Mb memory. With 
more free RAM, more drawings can be recorded (in 10 Mb, 850 drawings).

Q: Is the new ANIMAC incompatible with any Macintosh models?
A: The older models, such as the Plus, the old "Portable", the original Classic & LC, and 
other old models that have the slower 68000 chip cannot be used. Macs with the faster 
CPU chips and ADB mouse & keyboard should all work with the new ANIMAC. Also, 
System 7.0 or later is required.

Q: Can I watch my animation at 30 fps or some other speed instead of only 24 fps?
A: Yes! You can choose any speed between 1 and 30 fps as your base speed. Looping 
the drawings and playing according to the exposure sheet will then follow your choice of 
speed.    This is great for testing, and also very necessary if you produce animation to 
be shown at different frame rates —24 fps for movie theatres, 25 fps for European TV or 
30 fps for US TV.

Q: Why is the recorded image black & white instead of    grayscale or color? 
A: In order to handle up to 30 frames per second, you have to minimize the amount of 
data to be displayed. 
This is best done by limiting the image to B&W, since it uses only one eighth of the data 
required for a full grayscale image. However, you can simulate grayscale by letting 
ANIMAC rasterize the image. On Macs with greyscale or color monitors, you can 
choose between 3 different contrast levels. (Remember that "QuickTime" movies in 
even modest frame sizes cannot be shown at 30 fps on any but the most powerful 
Macintoshes. This is the reason for the choice to rasterize the image in B&W    —    to 
get top speed even on less powerful Macs!)

Q: Why doesn't the recorded image fill my big screen monitor, and why isn't ANIMAC's 
window resizable?
A: Same reason as above — a larger image is slower to display. This image size can be 
displayed at 30 fps on most Macintoshes, even on some of the laptop models. In order 
for ANIMAC to work on as many Macintosh models as possible, the program has a fixed 
window that completely fills the screen only on the smaller Macs. 

Q: Can I record live action?
A: You can record QuickTime live action "movies" with the camera's software - size and 
frames/sec depend on your Mac's power. This format is not used by ANIMAC, however. 
In ANIMAC, you can record time-lapse live action, one frame at a time.

Q: Can I transfer to videotape?
A: This depends on your Macintosh. If it has a direct video output connector (some AV 
Macs and third-party display cards have this feature), then you can record directly onto 
tape. Of course, you can always shoot directly off the Mac's screen with a camcorder... 
Some Macs may generate a rolling bar, though, if you shoot from the screen.
 



Q: Can the animation be shown on another Mac?
A: Yes! Thanks to the compact file format, up to several hundred drawings will fit on a 
single floppy disk. 
In addition, you may distribute the ANIMAC software freely — so you can bring a 
diskette and install a fully functioning demo version on a client's Mac, and leave your 
animation there for everybody to enjoy...    (If you have a PowerBook, you can take the 
ANIMAC system with you in a briefcase, without camera stand or lights, of course...    
Itinerant animators please note: a small pocket tripod enables you to set up ANIMAC 
anywhere!)

Q: Can I transfer my animation via modem or our office network to another Mac?
A: Yes! Using any communications program that supports Mac file transfer, you can 
send your animation anywhere in just a few minutes. Again, this is possible because the 
files are so small. If you use a network (such as AppleTalk or Ethernet), these small file 
sizes make network transfers a breeze!
 

Conditions for distributing copies of ANIMAC:

You may freely copy and give away the ANIMAC II program on these conditions:

• Any copy must be given completely free of charge. You may not even charge for the 
media (i.e. disk) on which ANIMAC is distributed.

Inclusion in shareware libraries on non-commercial BBS services is permitted ONLY if 
the release date (see top of this document) is no more than 6 months ago. If this is not 
the case, you may NOT distribute this version of ANIMAC. Instead, please obtain a later 
version, either from another BBS or directly from the author. This is to ensure that only 
the latest, most complete and error-free version is distributed. 

Commercial distribution (here defined as any distribution for which a charge is made for 
media and/or connect time, or any distribution together with a product offered for sale) is 
prohibited without prior permission from the author. Permission will not be unduly 
withheld, so please write or fax.

If you wish to receive an original disk with the latest version of ANIMAC, please send 
US$ 10 to address below (US cash, check or money order, please) to cover disk, 
packaging and air mail postage.

The latest version of ANIMAC is also available for download on the Internet at: 
"http://www.sci.fi/~animato".

• Any copies distributed must be completely unmodified. This means you may distribute 
ONLY the complete, unextracted archive, exactly as found on the disk, or as 
downloaded, not the individual files. This ensures all files are included with every copy 



you distribute.

• You may include your own animation, x-sheet and sound files with ANIMAC, but 
please clearly specify that they are your own, not a part of the ANIMAC software. If you 
include any copyrighted material in your files, the responsibility for any claims by any 
third party is entirely yours.

• ANIMAC is NOT "public domain", i.e. the author retains all copyrights to the program. 
The permission granted you to copy ANIMAC in no way diminishes the author's 
copyrights, nor does it give you any specific rights other than the right to copy and 
distribute the program as stated here.

• ANIMAC will run in demo mode on any computer not equipped with the "software 
enabler" that is supplied with a purchased copy of ANIMAC. It is unlawful to attempt to 
"break" this "demo protection" by disassembly, reverse engineering or any other means.

IMPORTANT DISCLAIMER:
The ANIMAC software is delivered as-is, with no warranty whatsoever. Since computer software is 
inherently complex and may not be completely error-free, absolutely no responsibility is taken for any 
costs including (but not limited to) those incurred as a result of lost profits or revenue, loss of use of this 
or other software, loss of data, cost of recovering software or data, cost of substitute software, claims by 
third parties, or any other consequential damage. You use the ANIMAC software on your own risk. For 
this reason, it is important that you always back up any important data. This is a normal precaution you 
should take with any and all software you use.

Any mentioned trademarks are owned by their respective companies.
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